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EXFO Communication Driver 

Driver for Serial Communication with 
WA-5900 (Fiber Bragg Grating Monitor) 
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Introduction 

The EXFO driver enables communication between the Studio system and devices using the proprietary protocol 

communicating over Serial, according to the specifications discussed in this document.  

This document was designed to help you install, configure and execute the EXFO driver to enable communication 

with these devices. The information in this document is organized as follows: 

 Introduction: Provides an overview of the EXFO driver documentation. 

 General Information: Provides information needed to identify all the required components (hardware and 

software) used to implement communication between Studio and the EXFO driver.  

 Installing the Driver: Explains how to install the EXFO driver. 

 Configuring the Driver: Explains how to configure the EXFO driver. 

 Executing the Driver: Explains how to execute the driver to verify that you installed and configured the driver 

correctly. 

 Troubleshooting: Lists the most common error codes for this protocol and explains how to fix these errors. 

 Sample Application: Explains how to use a sample application to test the EXFO driver configuration. 

 Revision History: Provides a log of all modifications made to the driver and the documentation. 

 Notes:  

• This document assumes that you have read the “Development Environment” chapter in the Studio 
Technical Reference Manual. 

• This document also assumes that you are familiar with the Windows NT/2000/XP environment.  
If you are unfamiliar with Windows NT/2000/XP, we suggest using the Help feature (available from the 
Windows desktop Start menu) as you work through this guide.  
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General Information 

This chapter explains how to identify all the hardware and software components used to implement 

communication between the Studio EXFO driver and the WA-5900 device.  

The information is organized into the following sections: 

 Device Characteristics 
 Link Characteristics 
 Driver Characteristics 

Device Characteristics 

To establish communication, you must use devices with the following specifications:  

Manufacturer: EXFO Electro-Optical Engineering Inc. 
Compatible Equipment:  

– WA-5900 (Fiber Bragg Grating Monitor)  

For a list of the devices used for conformance testing, see “Conformance Testing” on page 4. 

Link Characteristics 

To establish communication, you must use links with the following specifications: 

 Device Communication Port: RS-232 

 Physical Protocol: RS-232 

 Logic Protocol: Proprietary 

 Specific PC Board: None 

Driver Characteristics 

The EXFO driver is composed of the following files: 

 EXFO.INI: Internal driver file. You must not modify this file. 

 EXFO.MSG: Internal driver file containing error messages for each error code. You must not modify this file.  

 EXFO.PDF: Document providing detailed information about the EXFO driver 

 EXFO.DLL: Compiled driver 

 





Notes:  

• All of the preceding files are installed in the /DRV subdirectory of the Studio installation directory.  

• You must use Adobe Acrobat® Reader™ (provided on the Studio installation CD-ROM) to view  
the EXFO.PDF document. 

 

You can use the EXFO driver on the following operating systems:  

 Windows NT/2K/XP 

 

For a list of the operating systems used for conformance testing, see “Conformance Testing” on page 4.  
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Conformance Testing 

The following hardware/software was used for conformance testing: 

 Driver Configuration: 

– COM Port: COM1 

– Baud Rate: 115200 

– Data Bits: 8 

– Stop Bits: 1 

– Parity: None 

 

Driver 

Version 

Studio 

Version 
Operating System Equipment 

1.03 6.1 Windows XP WA-5900 
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Installing the Driver 

When you install Studio version 5.1 or higher, all of the communication drivers are installed automatically.  

You must select the driver that is appropriate for the application you are using. 

Perform the following steps to select the driver from within the application: 

1. Open Studio from the Start menu.  

2. From the Studio main menu bar, select File Open Project to open your application. 

3. Select Insert Driver from the main menu bar to open the Communication Drivers dialog.  

4. Select the EXFO driver from the Available Drivers list (as shown in the following figure), and then click the 
Select button.  

 

Communication Drivers Dialog Box 

5. When the EXFO driver displays in the Selected Drivers list, click the OK button to close the dialog. 

 
 

 

 Attention:    

For safety reasons, you must use special precautions when installing the physical hardware. Consult the 
hardware manufacturer’s documentation for specific instructions in this area. 
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Configuring the Driver  

After opening Studio and selecting the EXFO driver, you must configure the driver. Configuring the EXFO driver is 

done in two parts: 

 Specifying communication parameters 

 Defining tags and controls in the STANDARD DRIVER SHEETs (or Communication tables) 

Worksheets are divided into two sections, a Header and a Body. The fields contained in these two sections 

are standard for all communications drivers — except the Station, Header and Address fields, which are driver-

specific. This document explains how to configure the Station, Header and Address fields only. 

 

 Note:    

For a detailed description of the Studio STANDARD DRIVER SHEETs, and information about configuring 
the standard fields, review the product’s Technical Reference Manual.  

 

Setting the Communication Parameters 

Use the following steps to configure the communication parameters, which are valid for all driver worksheets 
configured in the system: 

1. From the Studio development environment, select the Comm tab located below the Workspace. 
2. Click on the Drivers folder in the Workspace to expand the folder.  
3. Right-click on the EXFO subfolder. When the pop-up menu displays (as shown in the following figure), select 

the Settings option. 

 

Select Settings from the Pop-Up Menu 
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The EXFO: Communication Parameters dialog displays (as follows). 

 

Communication Parameters Dialog 
 

 Note:    

The device must be configured with exactly the same parameters that you configured in the EXFO 

Communication Parameters dialog.  

 

4. Click the Advanced button on the Communication Parameters dialog to open the Advanced Settings dialog and 

configure the settings that are necessary. 
 

 Notes:    

 Do not change any of the other Advanced parameters at this time. You can consult the Studio 
Technical Reference Manual for information about configuring these parameters for future reference. 

 Generally, you must change the Advanced parameter settings if you are using a DCE (Data 
Communication Equipment) converter (232/485 for example), modem, and so forth between the  
PC, driver, and the host. You must be familiar with the DCE specifications before adjusting these 
configuration parameters.  
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Configuring the Driver Worksheets 

This section explains how to configure the STANDARD DRIVER SHEETs (or communication tables) to associate 

application tags with the device addresses. You can configure multiple Driver Worksheets — each of which is 

divided into a Header section and Body section.  

Configuring the STANDARD DRIVER SHEET 

 

Use the following steps to create a new STANDARD DRIVER SHEET: 

1. From the Studio development environment, select the Comm tab, located below the Workspace pane. 

2. In the Workspace pane, expand the Drivers folder and right-click the EXFO subfolder.  

3. When the pop-up menu displays (as shown in the following figure), select the Insert option. 

 

Inserting a New Worksheet 

 

 Note:  

To optimize communication and ensure better system performance, you must tie the tags in different 

driver worksheets to the events that trigger communication between each tag group and the period in 

which each tag group must be read or written. Also, we recommend configuring the communication 

addresses in sequential blocks to improve performance. 
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The STANDARD DRIVER SHEET displays (similar to the following figure). 

 

STANDARD DRIVER SHEET 

In general, all parameters on the Driver Worksheet (except the Station, Header and Address fields) are standard 

for all communication drivers, but they will not be discussed in this document. For detailed information about 

configuring the standard parameters, consult the Studio Technical Reference Manual.  

4.   Use the following information to complete the Station, Header and Address fields on this worksheet.  

 Station field: Not used for this driver. 

 Header field: Use the information in the following table to define the type of commands that will be read 
from or written to the device. 

 These commands must comply with the following syntax: 

<Command>  (For example: ID) 

After you edit the Header field, Studio checks the syntax to determine if it is valid. If the syntax is incorrect, 

Studio automatically inserts the default value in the Header field. 

Also, you can type a tag string in brackets {Tag} into the Header field, but you must be certain that the tag’s 

value is correct and that you are using the correct syntax, or you will get an invalid Header error.  

 Address field: Use this field to associate each tag to its respective device address. 

Type the tag from your application database into the Tag Name column. This tag will receive values from or 

send values to an address on the device. 

The following table lists all of the Commands and address that are valid for the EXFO driver.   
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Commands Address Comments 

ID 

0 Model 

1 Serial number 

2 Software version 

SPC 0 Spectrum output center. Range is 51 to 8141 (total range is 8192 data points) 

SPL 0 Spectra output length 

PFM 0 

The method used for locating channels 

 If x = 0, then the RTH value is used as a fixed threshold relative to the highest point in the spectrum. 
 If x = 1, then a peak is defined as a channel if the peak is greater than RTH above the local noise floor. 

RTH 0 The threshold level for channel definition 

WTH 0 The threshold level for wavelength calculation 

A 0 The number of spectra to be averaged 

NOR 0 Initiates a calibration of the source (Write only) 

BON 0 Turns broadcast mode on (Write only) 

BOFF 0 Turns broadcast mode off (Write only) 

WPO 0…255 Turns on wavelength/reflected power/OSNR measurement for continuous output / update (Read Only) 

WPOBOFF 0 Turns off continuous wavelength/reflected power/OSNR measurement output broadcast (Write Only) 

SW 0 The status word (Read Only) 

SPO 0 The spectral output for one measurement (Read Only) 

SPOBOFF 0 Turns off the continuous spectral output broadcast (Write Only) 

ASN 0 Auto-calibration off or on (0 or 1 respectively) 

NT 0 The interval between auto-calibrations in hours 

S 0…255 The window associated with sensor 

W 0…255 The range of window[j] 

SENABLE 0 
Enables peak search in each defined window, and polynomial conversion of each peak wavelength to an 
output value. Enter *1 to enable, and *0 to disable. 

SENSOR 0…255 The defined sensors for their output values (Read Only) 

DATE 0 The date (Write only) 

TIME 0 The time (Write only) 

EQX 
(Read only) 

0 
Equation that calculates pressure, temperature and delta pressure. This is a specific header for a specific 
client. 

INIT 
(Write only) 

 

1 P0 - Parameters for equations. This is a specific header for a specific client. 

2 TR - Parameters for equations. This is a specific header for a specific client. 

3 A11 - Parameters for equations. This is a specific header for a specific client. 

4 A12 - Parameters for equations. This is a specific header for a specific client. 

5 A21 - Parameters for equations. This is a specific header for a specific client. 

6 A22 - Parameters for equations. This is a specific header for a specific client. 

7 L1rt - Parameters for equations. This is a specific header for a specific client. 
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Commands Address Comments 

8 L2rt - Parameters for equations. This is a specific header for a specific client. 

9 L1rp - Parameters for equations. This is a specific header for a specific client. 

10 L2rp - Parameters for equations. This is a specific header for a specific client. 

11 Grad - Parameters for equations. This is a specific header for a specific client. 

CFG 
(Write only) 

0 Configuration header. This is a specific header for a specific client. 
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Executing the Driver  

After adding the EXFO driver to a project, Studio sets the project to execute the driver automatically when you 

start the run-time environment.  

To verify that the driver run-time task is enabled and will start correctly, perform the following steps: 

1. Select Project → Status from the main menu bar. 

The Project Status dialog box displays, as follows.  

 

Project Status Dialog Box 

2.   Verify that the Driver Runtime task is set to Automatic. 

 If the setting is correct, click OK to close the dialog box.  

 If the Driver Runtime task is set to Manual, select the Driver Runtime line. When the Startup button becomes 
active, click the button to toggle the Startup mode to Automatic.  

3.   Click OK to close the Project Status dialog.  

4.   Start the application to run the driver. 
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Troubleshooting 

If the EXFO driver fails to communicate with the device, the tag you configured for the Read Status or Write Status 

fields will receive an error code. Use this error code and the following table to identify the type of failure.  

 

Error Code Description Possible Causes Procedure to Solve 

0 OK Communication without problems None required 

1 ERROR PROTOCOL The driver receives an invalid message. Verify that the command is valid to read or write. 

2 
ERROR INVALID 
COMMAND 

The command specified in the Header field is 
invalid.  

Verify that the command specified in the Header field is 
valid. 

3 ERROR CONNECTION The equipment is not properly connected. Check connections.  

4 
ERROR 
CONFIGURATION 

If using (EQX), the Grad number informed might 
be different from the Grad number returned from 
the equipment. 

If (EQX), try to set different values for RTH and WTH to 
avoid noises. 

-15 Timeout Start Message 

 Disconnected cables 
 PLC is turned off, in stop mode, or in error 

mode 
 Wrong station number 
 Wrong RTS/CTS control settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

-17 Timeout between rx char 

 PLC in stop mode or in error mode 
 Wrong station number 
 Wrong parity 
 Wrong RTS/CTS configuration settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

 

 

 Tip:  

You can verify communication status with the Studio development environment Output window (LogWin 

module). To establish an event log for Field Read Commands, Field Write Commands and Serial Communication, 

right-click in the Output window. When the pop-up menu displays, select the option to set the log events. If 

you are testing a Windows CE target, you can use the Remote LogWin of Studio (Tools  Remote Logwin) to 

get the log events from the target unit remotely. 

 

If you are unable to establish communication with the PLC, try to establish communication between the PLC 

Programming Tool and the PLC. Quite frequently, communication is not possible because you have a hardware 

or cable problem, or a PLC configuration error. After successfully establishing communication between the 

device’s Programming Tool and the PLC, you can retest the supervisory driver. 

To test communication with Studio, we recommend using the sample application provided rather than your new 

application. 

If you must contact us for technical support, please have the following information available: 

 Operating System (type and version): To find this information, select Tools → System Information.  

 Studio version: To find this information, select Help → About. 

 Driver Version: To find this information, read the full description of the driver on the Communication Drivers 

Dialog Box. 
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 Communication Log: Displays in the Studio Output window (or LogWin window) when the driver is running. Be 

sure to enable the Field Read Commands, Field Write Commands and Serial Communication for the LogWin window. 

 Device Model and Boards: Consult the hardware manufacturer’s documentation for this information. 
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Sample Application 

You will find a sample application for drivers in the /COMMUNICATION EXAMPLES/EXFO directory. We strongly 

recommend that you check for a sample application for this driver and use it to test the driver before configuring 

your own, customized application, for the following reasons: 

 To better understand the information provided in each section of this document. 
 To verify that your configuration is working satisfactorily. 
 To certify that the hardware used in the test (device, adapter, cable and PC) is working satisfactorily before 

you start configuring your own, customized applications. 
 

Note:  

This application sample is not available for all drivers.  

 

Use the following procedure to perform the test: 

1. Configure the device’s communication parameters using the manufacturer’s documentation. 

2. Open and execute the sample application. 

 Tip:  

You can use the sample application screen as the maintenance screen for your custom applications. 
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Revision History  

Doc. 

Revision 

Driver 

Version 
Author Date Description of changes 

A 1.00 Eric Vigiani Dec/06/2004 Initial version 

B 1.01 Fabio Carvalho Apr/29/2005 New commands implemented for client – INIT, CFG, EQX 

C 1.02 Leandro Coeli Mar/15/2006 Changes in WPO 

D 1.03 Leandro Coeli Mar/15/2006 Cleaned the buffers 
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